
جانب ویژگ کنید، حتماً متوجه شدهاید که «سرعت» در این نرمافزار فقط یاست با فتوشاپ کار م اگر مدت
نیست، بله ی از ارکان اصل حرفهای بودن به حساب مآید. در این مقاله قصد داریم بهصورت کامل و کاربردی

بررس کنیم که چرا سرعت در فتوشاپ مهم است، چه عوامل روی آن اثر مگذارند و چونه متوانیم بدون افت
کیفیت، کار خود را سریعتر پیش ببریم.

دلایل اهمیت سرعت در فتوشاپ

چند دلیل اصل وجود دارد که نشان مدهد سرعت کار در فتوشاپ نباید نادیده گرفته شود:

۱. صرفهجوی در زمان شاید مهمترین و ملموسترین دلیل همین باشد. هر چه سریعتر کار کنید، در زمان بیشتری
متوانید پروژههای متعدد را انجام دهید یا حت زمان بیشتری برای استراحت و یادگیری مهارتهای جدید داشته

را ارائه دهید؛ چیزی که در دنیای رقابت ن، بهترین طراحتوانید در کوتاهترین زمان ممم باشید. سرعت بالا یعن
امروز ی مزیت بزرگ محسوب مشود.

۲. اهمیت سرعت در گرفتن پروژههای جدید وقت صحبت از کار با کارفرماها و مشتریها مشود، ی از اولین
چیزهای که برایشان اهمیت دارد، زمان تحویل پروژه است. کارفرما معمولا ددلاین مشخص دارد و طراح که بتواند

پروژه را سریعتر و با همان کیفیت تحویل دهد، شانس بیشتری برای جذب پروژههای بعدی و حت هماری بلندمدت
خواهد داشت. در بازار کار طراح، سرعت معقول به همراه کیفیت، تفاوت بین ی فریلنسر معمول و ی فریلنسر

موفق را رقم مزند.

۳. سرعت، نشانهی میزان تسلط شما سرعت کار در فتوشاپ معمولا بازتاب مستقیم از میزان مهارت و تجربهی
شخص است. هر چقدر سریعتر و در عین حال با کیفیتتر کار کنید، نشان مدهید که با ابزارها، شورتکاتها و
گردش کار (Workflow) فتوشاپ آشنای عمیق دارید. این موضوع بهخصوص در مصاحبههای کاری یا هنام

نمایش نمونهکار (Portfolio) برای کارفرماها بسیار به چشم مآید.

۴. کاهش خست ذهن و فیزی نتهای که کمتر به آن پرداخته مشود این است که کار طولان و کند با فتوشاپ
گردش کار شما روان و سریع باشد، انرژی ذهن افت تمرکز شود. وقت چشم، دست و حت تواند باعث خستم

کمتری صرف کارهای تراری مشود و متوانید آن انرژی را روی خلاقیت و جزئیات طراح متمرکز کنید.



آیا بالا بردن سرعت فقط به شورتکاتها خلاصه مشود؟

احتمالا وقت صحبت از افزایش سرعت در فتوشاپ مشود، اولین چیزی که به ذهن مرسد همان شورتکاتها
(Shortcuts) هستند. درست است که آشنای با میانبرهای فتوشاپ ی از مهمترین فاکتورهای افزایش سرعت

است، اما تنها عامل نیست. در ادامه چند عامل دیر را بررس مکنیم:

۱. تجربه و میزان آشنای با ابزارها

هر چقدر بیشتر با فتوشاپ کار کرده باشید و میانبرها برایتان به ی عادت تبدیل شده باشند، سریعتر عمل مکنید.
منظور از تسلط واقع این است که وقت مخواهید ی ابزار (Tool) را انتخاب کنید، اصلا نیازی به فر کردن
ندارید و دستتان بهصورت خودکار کلید میانبر را مزند. این نوع تسلط فقط با تمرین و ترار به دست مآید، نه

صرفاً با خواندن ی لیست از شورتکاتها.

۲. قدرت سیستم و نسخهی فتوشاپ

ی دیر از عوامل مهم، سختافزار سیستم شما و نسخهی نصبشدهی فتوشاپ است. هر چقدر سیستم شما قویتر
باشد (بهخصوص از نظر RAM، پردازنده و کارت گرافی)، طبیعتاً سرعت اجرای دستورات بالاتر مرود، لهای

کمتری تجربه مکنید و فرآیند رندرگیری و پردازش فیلترها سریعتر انجام مشود.

اگر سیستم ضعیف دارید چه باید کرد؟ خبر خوب این است که حت با ی سیستم نهچندان قوی هم متوانید کار را
تا حد زیادی روان کنید:

نسخههای قدیمتر و سبتر فتوشاپ مانند نسخهی ۲۰۱۵ یا ۲۰۱۷ را نصب کنید؛ این نسخهها معمولا منابع
کمتری مصرف مکنند.

اگر سیستم بسیار ضعیف است، حت متوانید به سراغ نسخههای قدیمتر بروید که نیازمندی سختافزاری
پایینتری دارند.

تنظیمات Performance فتوشاپ (در مسیر Edit > Preferences > Performance) را بررس کنید و
میزان RAM اختصاص دادهشده به فتوشاپ را بهصورت دست تنظیم کنید.

از فرمتهای سبتر برای فایلهای کاری استفاده کنید و در صورت امان، Smart Objectهای غیرضروری
را Rasterize کنید تا حجم پردازش کمتر شود.

تنظیم کنید؛ این کار بهتنهای خال SSD حافظهی را روی ی (Scratch Disk) محل ذخیرهی فایل موقت



متواند سرعت فتوشاپ را بهطور قابلتوجه افزایش دهد.
از فشار پردازش تواند بخشپردازیم نیز مهای فتوشاپ که در ادامه به آنها ماستفاده از هوش مصنوع

روی سیستم را کاهش دهد.

پیشنهادی : اصطلاحات و ابزارهای فتوشاپ

شورتکات چیست و چرا اینقدر روی آن تأکید مشود؟

شورتکاتها در واقع کلیدهای میانبر هستند که جایزین مسیرهای طولان در منوها مشوند. هدف اصل آنها این
است که شما را از رفتوآمد مداوم بین منوها و ابزارها رها کنند. برای مثال، بهجای رفتن به منو و کلی روی

گزینهی Copy، متوانید بهسادگ کلید ترکیبCtrl+C  را بزنید و در ی لحظه کپ بیرید.

شوند؛ تقریباً برای هر ابزار، هر پنل و هر دستور در فتوشاپ یمحدود نم Paste و Copy شورتکاتها فقط به
میانبر تعریف شده است. حت متوانید از بخش Edit > Keyboard Shortcuts، شورتکاتهای دلخواه خودتان را

برای دستورات که بیشتر استفاده مکنید تعریف کنید. این کار بهخصوص برای کسان که گردش کار تراری و
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مشخص دارند (مثل روتوشکاران یا طراحان تبلیغات) بسیار کاربردی است.

برای آشنای بیشتر متوانید مطلب «ترفند های فتوشاپ 2026» را نیز مطالعه کنید.

آیا بالا بردن سرعت کار به کیفیت آسیب مزند؟

این ی از سؤالات کلیدی و رایج در بین طراحان است. واقعیت این است که سرعت و کیفیت در بسیاری از موارد
رابطهای معوس با یدیر دارند؛ یعن اگر بخواهید سرعت کار را بیشتر کنید، معمولا بخش از کیفیت و جزئیات

قربان مشود، و برعس، اگر بخواهید روی کیفیت و جزئیات بیشتر تمرکز کنید، طبیعتاً زمان بیشتری صرف
مشود. اما نتهی مهم این است که متوان با روشهای مشخص، هر دو را به حداکثر ممن رساند؛ موضوع که

در ادامه به آن خواهیم پرداخت.
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چرا با افزایش سرعت، کیفیت کاهش میابد؟

بهتر است این موضوع را با ی مثال ساده توضیح دهیم. فرض کنید مخواهید ی فتومونتاژ یا روتوش چهره انجام
دهید. بدون ش وقت زمان کاف برای پرداختن به جزئیات داشته باشید، نتیجهی نهای بسیار جذابتر به نظر

مرسد. برای مثال:

روتوش دقیق ناحیهی چشم و مژهها
اصلاح پراکندگ موها و جداسازی طبیعتر آنها از پسزمینه

روتوش پوست بدون از بین رفتن بافت طبیع آن
تنظیم دقیق نور و سایه برای هماهن عناصر مختلف تصویر

اصلاح رنها و تن پوست برای هماهن کل ترکیببندی

هرچه زمان بیشتری روی این جزئیات بذارید، نتیجهی نهای حرفهایتر و باکیفیتتر مشود. اما طبیعتاً همین زمان
بیشتر، یعن سرعت پایینتر در تحویل کار.

چونه سرعت و کیفیت را همزمان به حداکثر برسانیم؟

خوشبختانه راهارهای وجود دارد که متوانید بر اساس زمان موجود، تعادل مناسب بین سرعت و کیفیت برقرار
کنید:

۱. استفاده از هوش مصنوع فتوشاپ برای کارهای زمانبر اگر پروژهای زمانبر است و فرصت کاف ندارید،
متوانید از ابزارهای هوش مصنوع داخل فتوشاپ یا ابزارهای جانب کم بیرید. برای مثال، بهجای انتخاب

دست و وقتگیر ی شخص از پسزمینه، متوانید از ابزار Select Subject استفاده کنید که در چند ثانیه انتخاب
نسبتاً دقیق برای شما انجام مدهد.

۲. تقویت مهارت در شورتکاتها نتهی مهم که باید به آن توجه کنید این است که مهارت در شورتکاتها هیچ
ارتباط به کاهش کیفیت طراح ندارد. اینطور نیست که اگر سریعتر بین ابزارها حرکت کنید، کیفیت کارتان افت
مکند؛ بله برعس، این مهارت صرفاً زمان غیرضروری که صرف رفتوآمد بین منوها مشود را حذف مکند و

وقت بیشتری برای پرداختن به جزئیات واقع طراح باق مگذارد.

۳. ارتقای سیستم در صورت امان اگر بودجه و امان آن را دارید، ارتقای سختافزار سیستم (بهخصوص RAM و



کارت گرافی) ی از مؤثرترین راهها برای افزایش سرعت بدون افت کیفیت است، چون این کار باعث مشود
فیلترها، افتها و پردازشهای سنین در زمان کوتاهتری انجام شوند، بدون اینه نیاز باشد از کیفیت چیزی کم

کنید.

۴. استفاده از Actionها و Presetهای آماده ی از روشهای بسیار کاربردی برای افزایش سرعت بدون آسیب به
کیفیت، استفاده از Actionهای فتوشاپ است. اگر مراحل تراری در کارتان دارید (مثلا ی سری تنظیمات رن و

کنتراست که همیشه روی عسها انجام مدهید)، متوانید آنها را یبار بهصورت Action ضبط کنید و در
پروژههای بعدی تنها با ی کلی همان مراحل را ترار کنید. این کار بهخصوص برای ادیت دستهجمع عسها

(Batch Processing) بسیار زمانبر را به چند دقیقه کاهش مدهد.

۵. استفاده از Smart Object و لایههای هوشمند کار کردن با Smart Objectها این مزیت را دارد که متوانید بدون
از دست دادن کیفیت اصل تصویر، تغییرات مختلف روی آن اعمال کنید و در صورت نیاز به آنها برگردید. این
موضوع باعث مشود مجبور نباشید کارهای زمانبر را از ابتدا ترار کنید و در نتیجه سرعت کل پروژه افزایش

میابد.
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پیشنهادی : راهنمای کامل استفاده از لایهها در فتوشاپ

انواع پروژهها و اهمیت سرعت یا کیفیت در هرکدام

پروژهها و طراحها انواع مختلف دارند و باید بسته به نوع پروژه، تصمیم بیرید که آیا باید روی سرعت تمرکز کنید
یا روی کیفیت و جزئیات:

پروژههای که به زمان و دقت نیاز دارند:

روتوش چهره و پرتره
فتومونتاژ و ترکیب چند تصویر

طراح تبلیغات و بنرهای حرفهای
پوستر و کاورهای موسیق طراح

ادیتهای تخصص محصول برای فروشاههای آنلاین

پروژههای که بیشتر به سرعت نیاز دارند:

مدارکنویس و کارهای اداری (مانند آمادهسازی عس پرسنل یا فرمهای اداری)
راری در طراحپیست کردن المانهای تکپ

استوری و پستهای سادهی اینستاگرام طراح
ههای اجتماعسهای شبادیت سریع ع

اصلاحات کوچ و جزئ روی فایلهای موجود

شناخت این تفاوت به شما کم مکند که انرژی و زمان خود را بهدرست مدیریت کنید و در پروژههای که نیاز به
دقت دارند، عجله ننید و در پروژههای که فقط سرعت اهمیت دارد، وقت زیادی روی جزئیات غیرضروری نذارید.

ی شورتکات طلای برای مدارکنویس و کپپیست

ها از آن غافل باشند و دقیقاً برای کارهای مدارکنویساز شورتکاتهای بسیار مهم و کاربردی که شاید خیل ی
و کپپیست بسیار مفید است، کلید ترکیبAlt+Tab  برای جابهجای سریع بین پنلها و فایلهای باز است. این میانبر
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متواند سرعت شما را در کارهای که نیاز به جابهجای مداوم بین چند فایل دارند، چندین برابر افزایش دهد.

علاوه بر این، چند شورتکات پرکاربرد دیر هم وجود دارد که شناخت آنها خال از لطف نیست:

Ctrl+J: ساخت سریع ی لایهی کپ از لایهی فعال

Ctrl+T: فعال کردن ابزار Free Transform برای تغییر اندازه و چرخش

Ctrl+Shift+Alt+E: ساخت ی لایهی Stamp Visible (ترکیب همهی لایههای قابلمشاهده در ی لایهی جدید

(بدون از بین رفتن لایههای اصل
Space (نهداشتن کلید): فعالسازی موقت ابزار Hand برای جابهجای سریع در صحنهی کاری

Ctrl+Alt+Z: بازگشت چندمرحلهای (Undo چندتای) برای اصلاح سریع چند مرحلهی اخیر

هنام کار با فتوشاپ، موزی گوش دهید!

تواند برای برخم دارد. موزی و طبیعتاً برای هر فردی نتیجهی متفاوت ،قانون قطع پیشنهاد است، نه ی این ی
افراد باعث افزایش تمرکز و آرامش ذهن شود، در حال که برای بعض دیر ممن است حواسپرت ایجاد کند.

توصیه مشود این موضوع را خودتان تجربه کنید و ببینید کدام حالت (سوت، موزی بکلام، یا حت پادکست)
بیشترین بازده را برایتان به همراه دارد.

تأثیر هوش مصنوع در افزایش سرعت کار با فتوشاپ

که این روزها بسیار مورد توجه قرار گرفته، استفاده از هوش مصنوع از مفیدترین و کاربردیترین گزینههای ی
در فرآیند طراح است. هوش مصنوع متواند در چند سطح به شما کم کند:

۱. کم گرفتن برای ایدهپردازی اگر در مرحلهی ابتدای ی پروژه هستید و نمدانید چه ترکیببندی یا رنبندی
مناسب است، متوانید از ابزارهای هوش مصنوع برای گرفتن ایده و الهام استفاده کنید.

۲. طراح مستقیم با هوش مصنوع حت متوانید از ابزارهای بخواهید که برای شما ی طراح اولیه بسازند و
سپس آن طراح را در فتوشاپ نهای و شخصسازی کنید. این کار متواند زمان زیادی در مراحل ابتدای پروژه

صرفهجوی کند.

فتوشاپ خود فتوشاپ هم در بخشهای مختلف از قابلیتهای هوش مصنوع داخل ۳. استفاده از هوش مصنوع



بهره مبرد. برای مثال:

بهجای انتخاب دست و زمانبر، متوانید از Select Subject یا Select Sky استفاده کنید.
ابزار Generative Fill که با استفاده از Adobe Firefly کار مکند، به شما اجازه مدهد بخش از تصویر را
بهصورت هوشمند گسترش دهید، عناصر جدید اضافه کنید یا حت پسزمینه را بهطور کامل تغییر دهید؛ آنهم

تنها با نوشتن ی توضیح متن ساده.
ابزار Neural Filters که امانات مانند تغییر سن، تغییر حالت چهره، بهبود کیفیت پرتره و حت رنآمیزی

هوشمند تصاویر سیاهوسفید را فراهم مکند.
قابلیت Content-Aware Fill که برای حذف هوشمند اشیاء از تصویر و پر کردن خلاقانهی پسزمینه استفاده

مشود و در بسیاری از موارد، نتیجهای بسیار طبیع و سریع ارائه مدهد.

استفادهی هوشمندانه از این ابزارها متواند بخش زیادی از کارهای تراری و زمانبر را بهطور قابلتوجه کوتاه
کند، بدون اینه کیفیت نهای کار بهطور محسوس کاهش یابد.

چند نتهی تمیل برای افزایش سرعت کار در فتوشاپ

در پایان، چند نتهی کاربردی دیر را نیز اضافه مکنیم که متواند به روانتر شدن گردش کار شما کم کند:

استفاده از Workspace شخصسازیشده: متوانید از طریق Window > Workspace ی فضای کاری
اختصاص بسازید که فقط پنلهای مورد نیاز خودتان در آن نمایش داده شود. این کار باعث مشود سریعتر

به ابزارهای پرکاربردتان دسترس داشته باشید.

https://firefly.adobe.com/


استفاده از Templates و فایلهای آماده: اگر پروژههای مشابه را بهصورت تراری انجام مدهید (مثل
طراح پست اینستاگرام)، ساخت ی قالب آماده با ابعاد و تنظیمات استاندارد متواند زمان زیادی را در

شروع هر پروژه ذخیره کند.
مدیریت صحیح لایهها: نامگذاری منظم لایهها و گروهبندی آنها (با استفاده از Ctrl+G) باعث مشود در

فایلهای پیچیده و چندلایه، سریعتر بتوانید عنصر مورد نظر خود را پیدا کنید.
یادگیری مستمر و بهروزرسان دانش: فتوشاپ بهطور مداوم بهروزرسان مشود و ابزارهای جدیدی به آن

اضافه مشود. پییری این تغییرات و یادگیری امانات جدید، خودش ی از راههای هوشمندانه برای حفظ
سرعت بالای کار در طول زمان است.

سخن پایان

سرعت در فتوشاپ موضوع است که از چند جنبهی مختلف باید به آن ناه کرد: تجربه و تسلط شخص، قدرت
سیستم، آشنای با شورتکاتها، و البته استفادهی هوشمندانه از ابزارهای هوش مصنوع. نتهی مهم این است که

سرعت بالا بهتنهای هدف نیست؛ هدف اصل رسیدن به بهترین نتیجهی ممن در کوتاهترین زمان منطق است. با

https://disiphee.ir/wp-content/uploads/2024/03/custom-photoshop-workspace.jpg


شناخت نوع پروژه، تقویت مهارتهای فردی و استفادهی درست از ابزارهای موجود، متوانید بدون آسیب جدی به
کیفیت کارتان، سرعت قابلتوجه هم در گردش کار روزانهی خود تجربه کنید.

سوالات متداول

۱. آیا یادگیری شورتکاتهای فتوشاپ بهتنهای کاف است تا سرعت کارم بالا برود؟ 

نه، شورتکاتها فقط ی از عوامل مؤثر هستند. سرعت واقع در فتوشاپ ترکیب از تجربهی شخص، تسلط بر
شورتکاتها، قدرت سیستم و حت استفادهی هوشمندانه از ابزارهای هوش مصنوع است. کس که فقط لیست

شورتکاتها را حفظ کرده باشد ول تجربهی کاف نداشته باشد، همچنان در عمل کند کار خواهد کرد.

۲. آیا افزایش سرعت کار حتماً به معن کاهش کیفیت طراح است؟ 

نه همیشه. درست است که در بسیاری از موارد سرعت و کیفیت رابطهای معوس دارند، اما با روشهای مثل
استفاده از Actionها، Smart Objectها و ابزارهای هوش مصنوع فتوشاپ (مانند Select Subject یا

Generative Fill)، متوانید بدون آسیب جدی به کیفیت، سرعت کارتان را بهطور قابلتوجه افزایش دهید.

۳. اگر سیستم من ضعیف باشد، چه راهاری برای افزایش سرعت فتوشاپ دارم؟ 

Scratch Disk تر فتوشاپ (مثل نسخهی ۲۰۱۵)، تنظیمتر و قدیمار وجود دارد: نصب نسخههای سبچند راه
روی ی هارد SSD خال، کاهش میزان Smart Objectهای فعال و Rasterize کردن آنها در صورت نیاز، و تنظیم

.Preferences > Performance اختصاصیافته به فتوشاپ از بخش RAM میزان دست

۴. چونه متوانم شورتکاتهای دلخواه خودم را در فتوشاپ تعریف کنم؟ 

از مسیر Edit > Keyboard Shortcuts متوانید برای هر ابزار یا دستوری که بیشتر استفاده مکنید، ی کلید
میانبر اختصاص تعریف کنید. این کار بهخصوص برای کسان که گردش کار تراری دارند (مثل روتوشکاران یا

طراحان تبلیغات) بسیار مفید است.

۵. آیا استفاده از هوش مصنوع در فتوشاپ باعث از بین رفتن خلاقیت طراح مشود؟ 

خیر، ابزارهای هوش مصنوع مثل Generative Fill یا Neural Filters صرفاً بخشهای زمانبر و تراری کار را



سریعتر مکنند (مثل انتخاب دقیق یا گسترش پسزمینه)، اما تصمیمگیری نهای دربارهی ترکیببندی، رنبندی و
حس کل طراح همچنان بر عهدهی طراح است. این ابزارها دستیار هستند، نه جایزین خلاقیت.

Action .۶ در فتوشاپ چیست و چه کم به سرعت کار مکند؟ 

بار آن را ثبت کنید و در پروژههای بعدی تنها با یتوانید یمجموعهای از مراحل ضبطشده است که م Action

Batch) سهاع همان مراحل را روی فایل جدید اجرا کنید. این قابلیت بهخصوص برای ادیت دستهجمع کلی
Processing) زمان زیادی صرفهجوی مکند.

۸. برای پروژههای که فرصت کاف برای پرداختن به جزئیات ندارم، چه کاری باید بنم؟ 

Select Subject، Content-Aware فتوشاپ مثل ار استفاده از ابزارهای هوش مصنوعدر این شرایط بهترین راه
Fill یا Adobe Firefly است که متوانند بخش زیادی از کارهای زمانبر را در چند ثانیه انجام دهند و وقت بیشتری

برای تمرکز روی جزئیات مهمتر باق بذارند.
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